TaskCentre® v4.5
Oracle Trigger Tool
White Paper

Document Number: PD500-03-03-1_0-WP

Orbis Software Limited © 2010

Table of Contents
COPYRIGHT ........................................................................................ 1
TRADEMARKS ...................................................................................... 1
INTRODUCTION .................................................................................. 2
Overview .......................................................................................... 2
Features ........................................................................................... 2
GLOBAL CONFIGURATION ................................................................... 2
TECHNICAL SUMMARY ........................................................................ 3
Working with other Steps.................................................................... 3
Dependencies .................................................................................... 3
Oracle Trigger Agent ...................................................................... 3
Objects Consumed ............................................................................. 4
Objects Exposed ................................................................................ 4
CONFIGURATION ................................................................................ 4
General ............................................................................................ 5
Main................................................................................................. 5
Oracle Browser .............................................................................. 7
Trigger ............................................................................................. 7
Configure ...................................................................................... 7
Script ..........................................................................................10

i

Copyright & Trademarks

Copyright
The copyright in this document is owned by Orbis Software 2010. All rights reserved.
This publication may not, in whole or part, be reproduced, transmitted, transcribed, stored in a
retrieval system or translated into any language in any form or by any means without the prior
written consent of Orbis Software Limited.
Head Office:
Orbis Software Limited (UK)
2 Nuffield Road
Nuffield Industrial Estate
Poole, Dorset
BH17 0RB
United Kingdom
Tel: +44 (0) 1202 241124
Fax: +44 (0) 1202 241125
Email: enquiries@orbis-software.com

Trademarks
Orbis Software Ltd owns the registered Trademark ‘TaskCentre’.
All other Trademarks used within this documentation are acknowledged as the property of their
respective owners.
The information provided in this publication may contain errors, omissions, or typographical
errors or may be out of date. Orbis Software may change, delete, or update any published
information at any time and without prior notice. The information published in this document is
provided for informational purposes only and is not binding on Orbis Software in any way except
to the extent that it is specifically indicated to be so.

1

Oracle Trigger Tool

Introduction
Overview
The Oracle Trigger Tool is used to create a Task Step that utilises the Oracle Server trigger
functionality to create a trigger on a table of a specified Oracle data source. When a specified
data modification is attempted, such as an attempt to add or delete a table row, the trigger
then causes a Task to run.

Features
A Trigger may be activated when any row is updated, deleted or a new row inserted.
A Trigger may be activated when specified columns are updated.
Values of updated, deleted or new rows may be mapped to variables for use in other Steps
within the Task.

Global Configuration
Before the Oracle Trigger Step the Oracle Agent must be installed and registered on the same
machine as the data source.
A User with System Administrator rights must then configure the Tool to select the Oracle Agent
and the synchronisation polling interval to be used when communicating with the it.ger Tool
requires no global configuration.
This is achieved through the Oracle Global Configuration dialog (Ref: Figure 1) which may be
opened by clicking on the Event node
Oracle Trigger icon

in the Task Manager and then double-clicking on the

in the Items List.

Figure 1. Oracle Global Configuration dialog.
The dialog consists of the followings:
'Oracle Agent' (drop down list) - A list of all Agents that are registered with the
TaskCentre server is displayed for selection.
'Agent Synch Polling Interval' (field) - A number representing the polling interval ins
seconds to be used to set how often the selected Agent checks for new/updated or deleted
triggers.
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Technical Summary
Working with other Steps
The Oracle Trigger Step is independent of any other Steps used in a Task. However, it accesses
parameters that the Task exposes through the Task Browser dialog.

Dependencies
The products, technologies, protocols or systems that are required for the Oracle Trigger Step to
work are listed below.
Oracle 8, 9 or 10 Data Source - All versions support the use of triggers on the following
platforms:
o

Linux – Linux kernels; 2.2, 2.4 and 2.6

o

Linux – Debian, Red Hat and other distributions

o

AIX

o

FreeBSD

o

HP – HP-UX (32 and 64 bit versions)

o

SGI Irix

o

DEC OSF1

o

Sun Solaris 2, 8, 9 and 10 (32 and 64 bit sparc and x86 versions)

o

Microsoft Windows NT, 2000, XP and 2003.

o

Microsoft Windows 98 and ME (console mode)

o

Apple Mac OS X

Oracle Trigger Agent - The agent must be installed on the Oracle Server.

Oracle Trigger Agent
The Oracle Trigger agent is a service that sits between TaskCentre and Oracle Server and may
be installed onto any Oracle Server. It is responsible for both maintaining the Triggers in Oracle
Server and for handling the running of a Task once a Trigger has been fired.
When an Oracle Trigger is fired, a connection is made to the agent service which will then
launch the applicable Task.
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Objects Consumed
The Oracle Trigger Step consumes no objects exposed by other Steps.

Objects Exposed
The objects that the Oracle Trigger Step exposes that can be utilised by other Steps are listed
below.
Variables (Text) - Textual data is mapped to selected Parameter Variables for use in other
Steps

Configuration
An Oracle Trigger Step is configured through the Oracle Trigger dialog which is displayed
through the following methods:
To create a new Step:
In the Task Browser dialog, select the 'Tools' tab click on the Oracle Trigger icon

under

the 'Event' node and then drag and drop- it onto the Task Plan. The Oracle Trigger dialog
will open and once created an icon for the Step will be displayed on the Task Plan.
In the Task Browser dialog, right-click on the Steps node and select the 'Oracle Trigger'
option from the 'New' > 'Event' drop down menu. The Oracle Trigger dialog will open and
once created the Step is displayed under the Steps node in the Task Browser. It may then
be dragged and dropped onto the Task Plan.
Right-click anywhere on the Task Plan in the Design tab of the Task dialog and selected the
'Oracle Trigger' option from the 'New' > 'Event' drop down menu. The Oracle Trigger dialog
will open and once created an icon for the Step will be displayed on the Task Plan.
To open an existing Step:
On the Task Plan in the Design tab of the Task dialog, double-click on the Oracle Trigger
icon

. The Oracle Trigger dialog will open to enable the Step details to be edited.

In the Task Browser dialog, double-click on the Oracle Trigger node

displayed under the

Steps node. The Oracle Trigger dialog will open to enable the Step details to be edited.
In the Task Browser dialog, right-click on the Oracle Trigger node displayed under the Steps
node and select the 'Edit Step' option from the drop down menu. The Oracle Trigger dialog
will open to enable the Step details to be edited.
The dialog has three tabbed panes described below through which an Oracle Trigger Step may
be created and configured.
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General

Figure 2. Oracle Trigger – General tab.
The contents of the ‘General’ tab (Ref: Figure 2) are as follows:
‘Name’ (field) – A unique name for the Step may be manually entered.
‘Description’ (field) – A description for the Step may be manually entered.

Main
The Main tab (Ref: Figure 3) provides options for configuring the connection to the required
database table to be used by the trigger and where more than one trigger has been created for
the Task the order in which it is run.
The contents of the ‘Main’ tab are as follows:
'Server' (area) - This area contains the following for selecting a server which is hosting the
required Oracle database:
o

'Select Server:' (drop down list) - Displays a list of all available Oracle Servers that
have the Oracle Trigger Agent installed for selection.

o

'Oracle SID' (field) – The Oracle server ID may be manually entered.

o

'Advanced' (button) – Opens the Oracle Port Number dialog (Ref: Figure 4) to enable
a port number to be manually entered.
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Figure 3. Oracle Trigger – Main tab.

Figure 4. Oracle Port Number dialog.
'Credentials' (area) - This area contains the following for setting the selected server login
credentials:
o

'Login Name' (field) - A valid login name for connecting to the selected server may
be manually entered.

o

'Password' (field) - A valid password for the selected login name may be manually
entered.

o

'Connect As' (drop down list) – Displays a list of user privileges for selection.

o

'Connect to Agent on port' (field) – The port number to be used to connect to the
Agent may be manually entered.
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'Select a Table' (area) - This are contains the following for selecting the required Oracle
database table or view:
o

'Trigger Table' (field) - Displays the table name selected from the Oracle database.

o

'Browse...' (button) - Opens the Oracle Browser dialog (Ref: Figure 5) to enable an
Oracle database table to be selected.

'Queue Trigger events if TaskCentre or Agent are unavailable to run Tasks' (option
check box) - If selected then the trigger events are stored until TaskCentre or the Agent are
available.

Oracle Browser

Figure 5. Oracle Browser dialog.
The Oracle Server Browser dialog is displayed when the 'Browse...' button for the 'Triggering
Table' field is selected in the Main tab of the Oracle Trigger dialog and is used to select a
database table to be used for the trigger

Trigger
The Trigger tab provides a comprehensive set of options for configuring the trigger. The dialog
has two tabbed panes listed below through which an Oracle Trigger may be created and
configured.

Configure
The Configure tab (Ref: Figure 6) provides configuration options to enable TaskCentre to
automatically create the necessary Oracle Script for the trigger. The script created may be
viewed by clicking on the Script tab.
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Figure 6. Oracle Trigger – Trigger tab - Configure.
The Configure tab contains the following:
'Trigger Type:' (option check boxes) - The following options are provided for selection:
o

UPDATE - When this trigger type is selected, the trigger is fired when a column in the
selected table is updated.

o

INSERT - When this trigger type is selected, the trigger is fired when a new row is
added to the table.

o

DELETE - When this trigger type is selected, the trigger is fired when an existing row
is deleted from the table.

'Fire Trigger:' (option radio buttons) - The following options are provided for selection:
o

BEFORE - When this trigger option is selected, the trigger fires before the table has
been updated.

o

AFTER - This is the default trigger option which fires the trigger after the table has
been updated.

'Run Task once for each Trigger' (option radio button) - If this option is selected then
the Task is run once for each trigger created for the Task. Numerous updates may therefore
be made to the table but the trigger will only fire once. No mapping of results set columns
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to Task Parameters is available, but any changes to the database that caused the trigger to
fire may be accessed through TaskCentre's memory feature.
'Run Task once for each Row in Results Set' (option radio button) - If this option is
selected then the Task is run once for each row in the results set.
'Map Columns to Task Parameters:' (table) - Displays a list of variables created for the
Task. The 'Columns' column contains a drop down list of columns for selection, from the
'Inserted' and 'Deleted' tables created by the Oracle Trigger, to be mapped against the
variable. The variable may then be used to expose the selected column value to subsequent
Steps.
'Only Fire Trigger when a selected Column is updated:' (option check box) - Selecting
this option activates the 'Columns' table displayed below it.
'Columns' (table) - Displays a list of columns available in the selected database table. A
check box is provided to the left of each column name for selecting / de-selecting the
column. The trigger is then fired when any of the selected columns is updated.
'Filter Table' (option check box) - Selecting this option activates the ‘Filter’ button so that
it may be selected.
'Filter' (button) - Clicking on the Filter button opens the Selecting the ‘Filter Table
Expression’ dialog (Ref: Figure 7) to enable a new expression to be entered.

Filter Table Expression dialog
The ‘Filter Table Expression’ dialog (Ref: Figure 7) is displayed when the ‘Filter’ button is
selected in the ‘Trigger’ tab of the ‘Oracle Trigger’ dialog.

Figure 7. Filter Table Expression dialog.
In the ‘Main’ tab of the Tool, an Oracle database and table are selected. You can configure the
trigger to fire when a specific column is updated but through the Filter Table Expression dialog
you may also create a filter expression on column values.
For example, a table is used to store the value of orders received in a column called 'Value'. The
Task runs a report to list all orders received with a value in excess of £10,000 and then sends it
to the Sales Manager.
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The report could be scheduled to run on a regular basis but the manager requires the report to
be run each time a new large value order is received.
The following expression is therefore created for the trigger 'Inserted.Value > = 10000' to cover
occurrences where the value is equal to or exceeds £10,000.
The dialog contains the following for creating a filter:
‘Columns’ (table) - Displays a list of columns available for the selected table.
‘Logical Expression’ (text box) - The expression is manually entered into this area. Any
columns listed in the 'Columns' table may be dragged and dropped into the text box for
inclusion in the filter expression.

Script

Figure 8. Oracle Trigger – Trigger tab - Script.
The Script tab (Ref: Figure 8) is provided to enable the Oracle Script for a trigger to be
manually created. When the tab is first selected it will display the Oracle Script automatically
created for the trigger through the Configure tab using the default options selected in the tab.
Selecting the 'Edit' button switches the tab to script mode so that the Oracle Script may be
manually edited. Once the script mode has been selected it cannot be reversed and the trigger
may only be edited by updating the Oracle Script
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